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I. General information  

Check the Organic Letters Electronic Manuscript Templates page before using the template to 

verify that you are using the most recent version. If necessary, download the appropriate version 

of the template and save it to your word-processing package (see section IV for directions).  

The template provides a number of paragraph styles that will allow you to format the different 

parts of your manuscript, i.e., Title, Author Names, Abstract, etc. This will facilitate review of 

your manuscript and allow you to determine whether your manuscript is within the Organic 

Letters page limit. In Microsoft Word, the name of the current paragraph style is displayed on the 

formatting toolbar in a box on the top left side of your screen (a "Styles" toolbar is also provided 

with the template to facilitate assigning the proper style; see sections V and VI for details). Each 

section of the manuscript must have a Word Style defining it. Do NOT modify any of the 

specifications of the template (text size, font, line spacing, line height, margins, etc.) to make 

your Letter fit the four-page limit. NOTE: If your paper is accepted, it will be formatted as part 

of the journal production process, and the appearance of the published paper may vary from what 

is in the template.  

Several tools are provided with the template: a "Styles" toolbar (mentioned above); a “Graphics 

and Tables” toolbar which can facilitate placing Figures, Tables, and Schemes in your 

manuscript; two ChemDraw .cds files which can be inserted into your ChemDraw application to 

assist in sizing your graphics correctly; an ACS reference formatter; and a help menu. These 

tools are described in section V.  

II. General instructions for preparing text in the manuscript  

Whether you are creating your manuscript from within the template or are applying the template 

to an existing manuscript, keep these points in mind as you format your paper.  

1. Use consistent notations and spellings throughout the manuscript.  

2. Turn off end of line hyphenation.  

3. Use the standard fonts from an English language word processor.  

4. Use Symbol fonts for all special characters (Greek and Math symbols). DO NOT use the 

basic Greek subset of the normal font which is found on some word processors.  

5. Use carriage returns only to end headings and paragraphs, not to break lines.  

6. Do not insert spaces before punctuation.  

7. Use the character that is intended [i.e., do not use l (ell) for 1 (one), O (oh) for 0 (zero), x 

(ex) for × (times)].  

8. Prepare tables with the format feature of your word processor and ensure that each data 

entry is in its own cell. 
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9. Remove from the file all material that is not to be printed in the journal. Supporting 

Information should be in a separate file.  

10. If “track changes” was used, remove all strike-outs before saving the file.  

11. Use a spell checker to detect any typos.  

12. To insert footnotes for author affiliations and contact information, do not use the Insert, 

Footnote command. After the first footnote has been inserted in the text portion of the 

manuscript, in the footnote section of the paper, place your cursor before the first 

footnote and create a blank line. In the new space created, type the footnote for the 

author, giving it a symbol rather than a number. Insert the symbol after the author name 

to which this footnote pertains.  

13. Pay particular attention to the format of the references to ensure that they comply with 

the style in use for the journal. The responsibility for accuracy of the references lies with 

the author. Tip: see section IX for recommended reference formats and for a description 

of the ACS reference formatter.  

III. Preparing graphics (structures, schemes, etc.) for the template  

A. General directions  

1. Use consistent drawing settings throughout the manuscript for similar artwork, e.g., all 

schemes and all figures. If not using ChemDraw, consult author guidelines for proper 

font/line settings.  

2. Ensure that your graphics are the correct size (maximum width for single-column 

artwork, 3.3 in. (8.5 cm); maximum width for double-column artwork, 7 in. (17.8 cm)) 

before pasting them into the template. Use the ChemDraw files provided with the 

template (described in section B) to facilitate this. If your graphics are too large, Word 

may modify the size, altering the resolution and making them unacceptable for 

publication. DO NOT resize or alter the graphics in Word.  

B. ChemDraw directions  

Follow the drawing settings in the ACS-1996 Style Sheet for preparing your artwork. It is best to 

copy the actual artwork and paste it into Word rather than saving it as a file and inserting it. In 

addition, for versions later than 2.1.3, in the ChemDraw Preferences (File, Preferences), ensure 

that the Optimize for High-Resolution non-Postscript Printing, Include ChemDraw 

LaserPrep, and Include PostScript Preferences are ON. Use of ChemDraw versions 2.1.3 or 

below and any version of ChemDraw Plus is not encouraged, as they are not compatible with the 

process that generates the PDF file for your manuscript. If it is absolutely necessary to use one of 

these older versions of ChemDraw, deselect Include PostScript Atom Labels (File, 

Preferences). This will prevent incompatible PostScript information from being embedded in the 

structure.  NOTE: this may result in structures of inferior quality; thus, the use of an updated 

version of ChemDraw is strongly encouraged.  
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NOTE: To assist in the creation of graphics, two ChemDraw Style Sheet files 

(1col_StyleSheet.cds and 2col_StyleSheet.cds) are provided in the ZIP file downloaded with the 

template (see section IV). The files contain a box. Open the files in ChemDraw and ensure that 

the graphic fits within the box to avoid its being reduced in size and distorted when pasted into 

Word. After creating the graphic, you should delete the box and save the file in ChemDraw. Now 

the graphic can be copied and pasted into the Word document without being resized.  

IV. Downloading the template  

1. Select the version of the Organic Letters template from the Organic Letters Electronic 

Manuscript Templates page that corresponds to the version of word-processing software 

you will be using to prepare your manuscript. Several zipped files will be downloaded: 2 

ChemDraw Style sheet files (see sections III and V-D) for details). The template will be 

downloaded as a “template” file rather than as a “document” file. (When you use a 

template file to create a document, the new document will be a copy of the template 

containing the information you input, and the original template file will remain 

unchanged.) In Word, it will have the file extension “.dot” instead of “.doc”.  

2. Save the file in the Templates folder of Microsoft Office 2000 (or Microsoft Word 

2000). NOTE: a dialog box will appear during downloading, asking where you want to 

save the file. Another screen may appear informing you that the file contains macros and 

asking if you want to Disable Macros, Enable Macros, or Do Not Open the file. It is safe 

to select "Enable Macros". The macros are popup toolbars containing elements of the 

template and do not contain any viruses.  

This document is now saved in the Templates folder with a “.dot” extension. See screenshot 

below (section VI.A). NOTE: If it does not appear, open the file and then save it with the file 

extension .dot. Use "save as" to save it into the proper directory/folder. Save the file as a 

document template (pull down File menu, select Save As, pull down the "save as type" box below 

"file name" in the "Save As" window, and choose "document template").  

3. Verify that the template has been saved correctly: (i) two popup toolbars should be 

visible (see section V for screenshots); (ii) "OrgLettHelp" and "AddReference" should 

appear on your Word menu bar.  

V. Template Features  

The template contains the proper margins and column settings for Organic Letters. There is no 

need to reset these, except if you are attaching the template to an existing document (see section 

VI-C). In that case, the margins etc. from the original document will prevail, and you will need 

to change them to the proper Organic Letters settings (directions are provided in section VI-C). 

The template also provides several features to simplify formatting your manuscript. 
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A. Pop-up toolbars  

These toolbars can be closed or minimized when not needed. To access a toolbar when needed, 

either maximize it or go to View , Toolbars and choose the appropriate toolbar (Styles or 

Graphics and Tables). These will be listed toward the bottom of the toolbar list.  

1. A "Styles" toolbar listing the Word Styles available for Organic Letters. Section VI 

provides directions on using the template styles.  

 

2. A "Graphics and Tables" toolbar to be used for inserting Figures, Tables, and Schemes 

into a manuscript. The tool generates space for the graphic, inserts the bars surrounding 

the graphic, and, if needed, a line for figure caption or scheme or table title/footnotes. It 

can also be used to insert the graphical abstract section. See section VII for directions on 

using this tool.  
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B. ACS reference formatter  

When used to create references, this tool formats them in proper ACS style (see section IX for 

full description). 
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C. Help menu  

This menu describes various parts of a manuscript and provides solutions to some common 

problems experienced when using the template.  

 

D. ChemDraw Style Sheet files  

Two ChemDraw Style Sheet files (1col_StyleSheet.cds, 2col_StyleSheet.cds) are provided in the 

ZIP file to serve as guides to properly size single and double column graphics (see section III for 

full description).  

VI. Working with text in the template  

There are several ways to use this template to generate your manuscript: (a) Use the template to 

create a manuscript, (B) copy and paste an existing document into the template, and (C) attach 

the template to an existing document. Detailed instructions are given below for each of these 

methods. Be sure to always check the Organic Letters Electronic Manuscript Templates page to 

ensure that you are using the most recent version of the template.  

A. Using the template to create a manuscript  

1. Create a document from the template by choosing File, New. You should see the Organic 

Letters template (OLMSW2000.dot) available for use in the General category.  
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2. Select the Organic Letters template (OLMSW2000.dot), and make sure that the option 

Create: Document (not Template) is selected. You will see a file containing sample text 

sections of a manuscript with tips for using the template and guidelines for what each 

section contains. This text is formatted with the paragraph style appropriate for the 

section. In addition, two popup toolbars should appear on your screen: (1) a "Styles" 

toolbar listing the Word Styles available for Organic Letters and (2) a "Graphics and 

Tables" toolbar to be used for inserting single- and double-column figures, schemes, and 

tables that generates space for the graphic, the bars surrounding the graphic, as well as 

the figure caption or scheme or table title. These toolbars can be minimized or closed and 

reopened for later use when needed ((1) View/Toolbars/Styles, (2) 

View/Toolbars/Graphics and Tables)).  

3. Select (highlight) the text of the template that you want to replace, and begin typing your 

manuscript (i.e., select the Title section for typing in your title), ensuring that you have 

selected text from the appropriate section (i.e., the Author Names section for typing in 

your author names).  

B. Copying and pasting a document into the template  

If you have prepared your document in a file not using the template, you can copy text from the 

existing document and paste it into the template file.  

1. Create a document from the template by choosing File, New. You should see the Organic 

Letters template (OLMSW2000.dot) available for use in the General category.  

2. Select the Organic Letters template (OLMSW2000.dot), and make sure that the option 

Create: Document (not Template) is selected. You will see a file containing sample text 

sections with tips for using the template and guidelines for what each section contains. 
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This text is formatted with the paragraph style appropriate for the section. In addition, 

two popup toolbars should appear on your screen: (1) a "Styles" toolbar listing the Word 

Styles available for Organic Letters and (2) a "Graphics and Tables" toolbar to be used 

for inserting single- and double-column figures, schemes, and tables that generates space 

for the graphic, the bars surrounding the graphic, as well as the figure caption or scheme 

or table title. These toolbars can be minimized or closed and reopened for later use when 

needed ((1) View/Toolbars/Styles; (2) View/Toolbars/Graphics and Tables).  

3. Print out the template file, so you can identify the proper styles for each section, in case 

you need to reassign a style while formatting your manuscript (see point 5 below).  

4. Open your existing manuscript file.  

5. Copy and paste the title, author information, and abstract information into the appropriate 

sections of the template. NOTE: be sure to include just the text from your original 

manuscript (not the paragraph symbol) (turn formatting symbols on to facilitate this – 

click on ¶ in the menu bar). If the paragraph symbol is copied, the style of your original 

document overrides the template style. To change the style back to the template style, 

click anywhere in the pasted-in text and select the proper Word Style from the popup 

"Styles" toolbar (or from the Word Styles list in the far-right box of the formatting 

toolbar).  

After pasting the title, author information, and abstract information, the rest of the 

manuscript can be copied into the text section and the proper styles applied once the 

manuscript is within the template. Click anywhere in the pasted-in text and select the 

proper style from the popup "Styles" toolbar (or from the Word Styles list in the far-right 

box of the formatting toolbar).  

NOTE: If all graphics are one column, both the text and the graphics can be copied and 

pasted in together, and the graphics can be formatted for Organic Letters within the 

template (red bars added, caption style changed, etc.). Two-column graphics must appear 

at the top of a page and should be included once the rest of the manuscript has been 

formatted. (see section VII-C for directions on two-column graphics).  

C. Attaching the template to a document  

If you have prepared your document in a file not using the template, you can attach the template 

to your working document and apply the template Word Style tags. If attaching the template to 

your document, you will need to print a copy of the template first so that you can identify which 

Word Style should be applied to the different sections of your manuscript (File, New, and select 

the Organic Letters template).  

1. Open your manuscript file.  

2. Select Tools on the toolbar and then Templates and Add-Ins. NOTE: there are several 

ways to import templates/styles into working documents within Word. See the 

“templates” section of Microsoft Word Help for further instructions.  
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3. Select the Automatically Update Document Styles box (failure to do so will not copy 

the template Word Styles into the working document).  

 

4. Select Attach and highlight the file OLMSW2000.dot.  

5. Select Open. This selects the template.  

6. Select OK. This will return you to the working document.  

7. Check that the template has been successfully attached: You should see the "Styles" and 

"Graphics and Tables" toolbars, or they should be listed under View/Toolbars. The Word 

Styles menu in the far-right box of the formatting toolbar should now contain the 

template styles (e.g. bar etc.).  

8. Change the page layout. Under Format, select Document. On the Margins tab, type in 

the following dimensions to ensure your manuscript is the proper size: Top 0.5”, Bottom 

0.66”, Left 0.76”, Right 0.76”, Gutter 0”, Header 0”, and Footer 0”. Under Page Setup, 

select Paper US Letter. NOTE: This is necessary since the page layout from your 

original document is NOT changed when the template is attached to it  

9. Place the cursor in the title section of your document. Using the "Styles" toolbar that 

appears with the template or the Word Style menu on the formatting toolbar, select Word 

Style “Title of Manuscript”. This will apply the Word Style to the title. Do this for the 

author names and author addresses using the appropriate style.  

10. Leave space after the author address for the Received Date (added by the editorial office) 

by typing Received Date on a blank line and tagging it Word Style “Received Date”. This 
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will leave the appropriate amount of space so that an accurate approximation of the 

length of the Letter is made.  

11. You will need to create the graphical abstract section: select "Insert Abstract" from the 

"Graphics and Tables" toolbar. This will create a thick red bar, a graphic box, into which 

you will insert the artwork, a line for the abstract text, and a thin red bar below the text. 

12. Assign the appropriate Word Styles to the remainder of the paper.  

VII. Inserting Figures, Schemes, and Tables into the template  

In Organic Letters, Figures, Schemes, and Tables are formatted with red bars above and below 

them. (All other graphics, e.g., equations or in-line structures, are inserted into the text without 

bars.) Once you have created the desired item in, for example, your structure drawing program, 

you have two options for creating correctly formatted Figures, Schemes, or Tables in the 

template: using the "Graphics and Tables" toolbar or creating them manually. The macros in the 

toolbar will generate the red bars and tag the correct style for the title, caption, or footnote.  

 A. Using toolbar to create Figures, Schemes, or Tables  

Use the popup toolbar titled “Graphics and Tables” (View\Toolbars\Graphics and Tables). 

Place the cursor where you wish the Figure, Scheme, or Table to appear. Select the appropriate 

item. A template for that item should appear (bars, a space for the graphic, and a line for 

caption/title /footnotes).  

If you are inserting a Figure or Scheme, highlight the words “Insert Graphic Here” (not 

including the paragraph symbol) and paste in the graphic. The graphic should be the size at 

which it will be printed in the journal (see section III above). Check to ensure that the thick and 

thin red bars enclosing the graphic are present.  

If you are inserting a table, adjust the number of rows or columns as necessary.  

Add caption, title, and/or footnotes where indicated.  

NOTE: If you wish to delete a figure, scheme, or table, the most efficient way would be to 

highlight the graphic or table (including the red bars) and hit the backspace or delete key. If you 

choose to use the undo arrow on the menu bar, it must be selected several times until all 

components of the table or graphic have been deleted.  

B. Creating/Formatting Figures, Schemes, or Tables manually  

1. Formatting existing graphics or tables: If you have copied and pasted a manuscript into the 

template which contains properly sized one-column graphics or tables, you will need to add the 

red bars and apply the proper style for captions, etc. Use the "Styles" toolbar (bottom section 

contains red bars and caption styles).  
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2. Adding Figures, Schemes, and Tables to a manuscript: (note: this is the method that has been 

available in the older templates (downloaded before 2004)). Add four blank lines where the 

Figure, Scheme, or Table is to be inserted. Using the popup toolbar titled “Styles” 

(View\Toolbars\Styles), click in the first line and select the “Thick Red Bar” Word Style (a 

thick red bar should appear that spans the column). If you are creating a Scheme or Table 

section, in the second line select the Word Style “Scheme Title” or “Table Title”, in the third line 

the Word Style “Normal Text”, and the in fourth line the Word Style “Thin Red Bar”. If you are 

creating a Figure section, the second line should be Word Style “Figure Caption” and the fourth 

line Word Style “Thin Red Bar”. Paste the graphic in the line Word Style “Normal” (see section 

III above).  

C. Double column Figures, Schemes, and Tables  

1. Using the toolbar:  

Start at the top of the page.  

Click on the appropriate entry from the "Graphics and Tables" toolbar.  

This will change the format to one column, insert red formatting bars, and provide lines for 

inserting the graphic or table plus appropriate text such as captions or footnotes. The format 

below the lower red line will be returned to two columns.  

2. Manually:  

Start at the top of a page.  

Place the insertion point where you want to change the number of columns.  

From the Insert menu, choose Break.  

Under Sections, choose Continuous.  

Make sure the insertion point is in the new section.  

From the Format menu, choose Columns.  

In the Number of Columns box, type 1.  

Choose the OK button.  

Now your page is set up so that Figures, Schemes, and Tables can span two columns. These must 

appear at the top of the page. Be sure to add another section break after them and change back to 

two columns with a spacing of 0.33 in.  
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D. Inserting other graphics into the template  

Graphics such as equations and simple structures can be included in an Organic Letters 

manuscript. These graphics do not require the red formatting bars.  

To insert a graphic within the text, create a new line (select Word Style "Normal ") and insert the 

graphic where desired.  

NOTE: Paste the graphics at the size they will be printed in the journal: If your artwork is larger 

than the width of a column, Word may reduce the size so that it fits within the column. This will 

alter the resolution of your graphic, making it unacceptable for publication. You must resize the 

artwork in your graphics program and repaste it into the file. DO NOT resize or add labels to 

the artwork from within Word: the maximum width for single-column artwork is 3.3 in. (8.5 cm); 

maximum width for double-column artwork is 7 in. (17.8 cm).  

VIII. Troubleshooting graphics problems  

Abstract graphic is resized: When inserting graphics into the Abstract graphic box, Word may 

expand the graphic to fill the box. To prevent this, delete the graphic box, create a new line 

(select Word Style "Normal"), and insert the graphic.  

Graphic not visible: If you cannot see your graphic, or only see the bottom line of a graphic, 

ensure that the Word Style is “Normal” with an automatic height adjustment (from the Format 

menu, choose Paragraph; under Line Spacing, choose Single).  

Graphic overlaps text: If your artwork does not appear where you placed it and is floating over 

text, select the piece of artwork by clicking on it. Under Format, select Picture or Object and 

then click the Position tab. Make sure the Float over text box is NOT selected. If it is, deselect 

it and select OK. This should make your artwork appear where you originally placed it.  

Closing up spaces when graphics move and red bars become separated. If you make 

additions or corrections to a manuscript from within the template after you have formatted the 

graphics with the enclosing red bars, these red bars may get separated from the graphic if there is 

not enough space in a column for all parts of the formatted graphic. This can leave white space in 

a column. These white spaces will be corrected once a manuscript is prepared for publication. 

However, if you wish to close them up (e.g., to more accurately estimate whether your paper 

falls within the 4 page limit), follow the directions below:  

After inserting the text and editing the manuscript with graphics in place, check all graphics 

starting from the beginning of the manuscript. If the bars have become separated, leaving white 

space, move text from above or below the graphic as needed to fill the space. If bars become 

separated, leaving no white space, place your cursor at the end of the line preceding the thick red 

bar, hit RETURN until the graphic or table appears properly with the red bars above and below 

it, and then fill in the new white space with text from below the graphic. Turn on formatting 

symbols so you can see how many lines of text need to be moved.  
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NOTE: When your word processing file is converted to a pdf file, the graphics are sometimes 

moved, creating white spaces. As long as your manuscript is within the 4 page limit as formatted 

in the word processing file, there is no need to reformat the file to close the spaces created by 

converting to pdf. The pdf file is used only for the review process. 

 

IX. References  

A. Author affiliation footnotes  

To insert footnotes for author affiliations and contact information, do not use the Insert, 

Footnote command. After the first footnote has been inserted in the text portion of the 

manuscript, in the footnote section of the paper, place your cursor before the first footnote and 

create a blank line. In the new space created, type the footnote for the author, giving it a symbol 

rather than a number. Insert the symbol after the author name to which this footnote pertains.  

B. ACS Reference Formatter instructions  

If you are creating your manuscript within the template (rather than reformatting an existing 

manuscript), you can take advantage of the ACS Reference Formatter available with the template 

to create references that are formatted in proper ACS style. (Note: when keying in the author 

initials, the periods should be included as well.)  

You can also use the Formatter if you need to add a reference once a manuscript is in the 

template. However, you cannot format an existing reference using this tool.  

There are two ways to insert reference text using the ACS Reference Formatter: (1) Using the 

Insert, Footnote feature in Word and (2) Not using the Insert, Footnote feature in Word.  

(1) Using the Insert, Footnote features of Word  

(a) Insert the footnote where desired, and when you are in the footnote editor, click 

on AddReference on the menu bar. (If this item is not available on your menu 

bar, press ALT-R and the formatting box will appear.)  

(b) In the form that pops up, choose the Journals tab to insert a journal reference, 

Books to insert a book reference, and Other for all other citations.  

(c) Type in the required information in the labeled boxes and press OK to enter the 

reference text in the ACS format.  

(d) Press the Cancel/Close button to return to the Word document.  

(2) If you are not using the Insert → Footnotes feature, click on AddReference and use 

the form to insert all the references in sequence. (If this item is not available on your menu bar, 

press ALT-R and the formatting box will appear.)  
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C. EndNote program: style information  

If you are using the EndNote program to manage your citations, use the style 

J_Organic_Chemistry.ens to format your references.

D. Recommended reference formats  

Journals: Author 1; Author 2. Journal Abbreviation year, volume, pages. For example: Smith, J. 

A.; Jones, B. R. Org. Lett. 1999, 1, 1.  

Books with Editors: Author 1; Author 2. In Book Title; Editor 1, Editor 2, Eds.; Publisher: Place 

of Publication, year; volume, pages. For example: The ACS Style Guide, 2nd ed.; Dodd, J. S., 

Ed.; American Chemical Society: Washington, DC, 1997.  

Books without Editors: Author 1; Author 2. Book Title; Publisher: Place of Publication, year; 

volume, chapter, pages. For example: Stothers, J. B. Carbon-13 NMR Spectroscopy; Academic: 

New York, 1972; Chapter 2.  

U.S. Government Publications: Author 1; Author 2. Document Title; Government Publication 

Number; Publisher: Place of Publication, year; pages. For example: National Handbook of 

Recommended Methods for Water Data Acquisition; Office of Water Data Coordination, U.S. 

Geological Survey: Reston, VA, 1977; Chapter 5.  

Technical Reports: Author 1; Author 2. Title; Technical Report Number; Publisher: Place of 

Publication, year; volume, pages. For example: Schneider, A. B. Expert Systems in Analytical 

Chemistry; Technical Report No. 1234-56; ABC Company: New York, 1985.  

Patents: Author. Patent number, year. (Patent number with reference to country granting the 

patent.) For example: Lyle, F. R. U.S. Patent 5 973 257, 1985; Chem. Abstr. 1985, 65, 2870.  

Thesis: Author. Level of Thesis, Degree-Granting University, Location of University, date. For 

example: Fleissner, W. Ph.D. Dissertation, University of Tennessee, Knoxville, TN, 1984.  

Series: Author 1; Author 2. In Title; Editor 1, Editor 2, Eds.; Series Title and Number; Publisher: 

Place of Publication, year; volume, pages. For example: Nonlinear Optical Properties of 

Organic Polymeric Materials; Williams, D. J., Ed.; ACS Symposium Series 233; American 

Chemical Society: Washington, DC, 1983.  

Citation to Meetings: Author 1; Author 2. Title of Presentation. Published Title of Collected 

Work, Proceedings of the Name of the Meeting, Location of the Meeting, Date of the Meeting; 

Editor 1, Editor 2, Eds.; Publisher: Place of Publication, year; abstract number, pages. For 

example: Baisden, P. A. Abstracts of Papers, 188th National Meeting of the American Chemical 

Society, Philadelphia, PA; American Chemical Society: Washington, DC, 1984; NUCL 9.  
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X. Saving your manuscript in the template  

When you are finished and are ready to save your document, if necessary, delete all sections 

from the template that are not needed. Assign the file a name that will identify your manuscript, 

one that is different than that of the template. Save the file with the graphics in place. In 

Microsoft Word, click Save (File menu) and save it as a “document” file (.doc). 

XI. Checking your manuscript for completeness  

Proof a printout of the manuscript (from a 600 dpi or higher laser printer) to ensure that all parts 

of the manuscript are present and clearly legible.  

XII. Submitting your manuscript  

Follow the Info for Authors link from the Organic Letters home page for the latest instructions 

on how to proceed with the submission of your manuscript. If submitting electronically, your 

manuscript will be converted to a PDF file. If generating your own PDF file, click here for tips 

on proper PDF generation. The PDF file is used strictly for peer review. The length of the file 

when converted to the PDF version may change. NOTE: If your manuscript fits within four pages 

in the word-processing template and exceeds this length only after conversion to PDF, there is 

no need to readjust the length of your file in Word to make it fit the four-page limit. Additional 

formatting changes may occur. In addition, the appearance of footnote numbers does not need to 

be changed to match the journal style.  

XIII. Additional resources  

Authors should refer to the User’s Guides for their individual word processor and graphics 

programs for more specific instructions on how to use these packages. In addition, most software 

manufacturers maintain on-line help resources. Two good sources of additional information are 

the Microsoft Web site and the ChemDraw Web site.  
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